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» What is a Style Sheet?

» Advantage of a Style Sheet;

» Download and Installation;

» Getting started with lulm Style Sheet Template;

» Creating a document based on the Style Sheet template;
» Applying the Style Sheet to an existing Word document;
» Generating an automatic Index/table of contents;

» Special page numbering;

» Converting your thesis to PDF;

» Other useful Word functions for your thesis;
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WHAT IS A STYLE SHEET?
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> A style sheet is a predesigned thesis template based on
Word styles;

» A style is a set of text formatting characteristics applied
to content (chapter style, thesis body style, citation

style, margins, font type, paragraph line spacing...)
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ADVANTAGES OF USING IULM STYLE SHEETS
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» lulm thesis formatting template provides built-in formatting for
text and heading styles, margin settings, section breaks and page
numbering, and place-holders for automatically generated table
of contents, lists of figures, tables and plates...

» lulm Style Sheet is the great way to save time and create
consistent Office documents: using styles to format your thesis so
you can quickly and easily apply a set of formatting choices

consistently throughout your document.
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Connect to lulm
Website ;
Then click
«Mylulm» /
Services for
students /Press
centre and
dissertation
services

And Download
lulm Style Sheet
template

IULM STYLE SHEET DOWNLOAD
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£ Risultati divicerca - Google Drive X | gf Demalizione auta| Ritiro gratuit X | @ Sano un privato, come faccio s X | & "rispasta termpestiva e’ - Cerca X [B] Services for students x  + =& % |
&« > C & iulm.itfen/myiulm fservizi H A & &% m@® Q0 a0 =™ 2 Bk N . [+]
HIoApp * Bookmarks & Google Google [ Yahoo Importati da[E 585 Sci-Hub: removing... @ Unimare bibliograp... @ Welcome to Sensus.., [ Basic principles of ... » Altri Preferiti

‘- UNIVERSITA
I[']IM @ e

PRESS CENTRE AND DISSERTATION SERVICES /

To help you in the prepgration of vour dissertation or final test, you can download some of the media below by clicking
directly on the approprifite link. These are tools made by [ULM University with all the indications about formatting and
editing of your dissertatfon. However, they do not replace the indications of the lecturers for the structuring of the work but
represent an aid for thefediting work.

¢ Tips for formatizae &g instructions for delivery and printing
e The model offthe style sheet whichYllows you to obtain a structured, standardized document with an automatic layout;
e The guide to wgggf the shde®anual containing information about applying Word stylesto editing:

¢ Theillustrated editing support

Contacts

Forany clarification regarding the editing and formatting of the document, you can contact the staff at the Multimedia
oom [IULM 1, 3rd floor) by writing to biblioteca.multimediale@iulm.it or calling +3% 02 891412483

GO 0 E[E]8 0 CT55 ¥ o= TR
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Open and
Save the
stylesheet as
a Word
template in a
folder on
your
computer
(preferably in
Templates)

GETTING STARTED WITH THE STYLE SHEET
TEMPLATE DOWNLOAD

Document? - Compatihility Mode - Word Signin © @

Pinned

@ Recent .
Pin folders you want to easiy find later. Click the pin icon that appears when you hover aver a folder.
Today

. OneDrive
D Documenti

Other locations

This BC Last Week

D E

=1 Modelli ci Office personalizzati

E] Browse
D Desktop
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CREATING A DOCUMENT BASED ON IULM STYLE SHEET
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New

Click on File, then () Home
CliCk on New: 19 New Search for online templates Jo
> Under B3 Open Suggested searches: Business Cards Flyers letters Education Resumesand Cover Letters  Holiday
Templates click
New from .
Personal and
Select lulm
Stylesheet
(format .dot) Ee

Share

Save

Save As

Export
Transform lulm_StyleSheet foglio prova foglio_di_stile_tesi_julm_2016

Close
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APPLYING THE IULM STYLE SHEET TO AN EXISTING DOCUMENT

PREVIOUS VERSIONS OF WORD 2007 AND WORD ON MAC
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If you have already Click tools, templates and Add-Ins

started writing your Select Attach:

thesis, you can still apply Open lulm Style Sheet, click Open and Insert a
the style sheet to your checkmark in the box «Automatically update

document, proceeding styles» to apply lulm Style Sheet to your file
as follows:

Organiser... Cancel ST
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APPLYING IULM STYLE SHEET TO AN EXISTING TEMPLATE
WORD 2007 AND LATER VERSIONS
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Enable «Show
Developer» Tab
(Word Customer
Ribbon Bar);

Click on Developer
Select tools,
templates and
additions; :
Click on Attach; S Y =rEvr—
Open the desired  (CEEESSREET BEEaul S
template and click
Open;

Enter a checkmark

T Q 0 do...
XMLMapping ~ Block Restrict Document
Pane

Authors - Editing  Template
Mapping Protect Templates

Templates XML Schema XML Expansion Packs Linked C55
in the box Document tempiate )
. “edm-fs.iulm.local\profilesS\FolderRedirection\lbrahima.Mbengue\Dy Attach...
((Automatlca"y utomatically update document styles; /
Attadl - q

update styles» to
Checked items are currently loaded.

apply lulm Style
Sheet to your file

Full path:

I[ULM Library / Multimedia Services



STARTING WITH IULM STYLE SHEET
DISPLAYING AND SAVING THE FILE
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Layout model

iulm_stylesheet 2016 [Compatibility Made] - Word

Design  Layout  References  Mailings  Review  View  Developer Q@ Tellr

2

TimesNewF-[13 -/ A A" Aa~ « AzBbC aaBhccd AaBb AaBb AaBbCcl 1. AsBb AaBh( A4aBbCel

Paste Bulleted list Figure Ca... Introd/Co... Main Cha... | TNormal | Numbere.. paragraph.. Picture/Fi.. |-

: . 2 aky _ -
 Format Painter ¥l echts & A

Clipboard & Font [ Paragraph [ Styles r

Assign a name (Student Table of contents T— "
ID Number - First Name ——

1 Main Chapter’s Title Level 1
1.1 Paragraph Title Level 2.
1.1, Paragraph Title Level 3
11.1.1 Paragraph Title Level 4

Last Name) to the new
template FiF ety

1.2 Paragraph Title Level 2.

e e

1.2.1 Paragraph Title Level 3
1.2.1.1 Paragraph Title Level 4.
1.2.1.2 Paragraph Title Level 4.
1.2.1.3 Paragraph Title Level 4.

Titolo capitolo 2

2.1 Paragraph Title Level 2.
2.1.1Paragraph Tifle Level 3
2.1.1.1 Paragraph Title Level 4.
2.1.12 Paragraph Title Level 4
2.1.13 Paragraph Title Level 4.
2.2 Paragraph Titls Lavel 2.
221 Paragraph Title Level 3
2211 Paragraph Title Level ¢
2212 Parazraph Title Level
2213 Paragraph Title Level

Titolo capitolo 3
3.1 Paragraph Titie Level 2.
3.1.1 Paragraph Title Level 3
3.1.1.1 Paragraph Title Level 4
3.1.1.2 Paragraph Title Level 4
3.1.1.3 Parazraph Title Level 4
Page6of26 1186 words [|¢  English (United Kingdom)
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STARTING WITH IULM STYLE SHEET

OPENING AND SAVING THE FILE
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Home  Inset  Design  Layout  References  Mailngs  Revi m@e o T .
N Outline Ruler [E) [El one Page D [Tl View Side by Side co D

The Navigation Pane

- FEIIENES Q =
lets vou navigate through SW0nn [ arines B Qwupierages | L) Snehionous scroling |
Read = Print  Web Zoom 100% New Arrange Split Switch Macras
S Lavout La | Navigation Pane B Page Width Window Al Re indow Position | Windgws - =

your document without

) Navipation v &
scrolling o Tabie of contents
Headings ~ Pages  Results INTRODUCTION/PREMISE 1
i *s Ti vel 1
4 1 Main Chapter's Title Level 1 1 Main Chapter's Title Level 4
1.1 Paragraph Titie Levei 2. 4
4 1.1 Paragraph Title Level 2 1.1. Paragraph Title Level 3 4
I 1.1, Paragraph Title Level 3 1.1.1.1 Paragraph Title Level 4 4
1.1.1.2 Paragraph Title Level 4 4
4 1.2 Paragraph Title Level 2 1.1.1.3 Paragraph Title Level 4 4
b 121 Paragraph Title Level 3 1.2 Pavagraph Title Level 2. 5
. 1.2.1 Paragraph Title Level 3 5
4 Titolo capitolo 2 zrap
(DS 1.2.1.1 Paragraph Title Level 4 5
4 2.1 Paragraph Title Level 2 12.12 Paragraph Title Level 4 5
I 2.1.1Paragraph Title Level 3 1.2.1.3 Paragraph Title Level 4 5
4 2.2 Paragraph Title Level 2 Titolo capitolo urrent Document
b 221 Paragraph Title Level 3 2.1 Paragraph Tuls Levst  Cri+Click to follow link
Y 2.1.1Paragraph Title Level 3
Titolo capitelo 3 2.1.1.1 Paragraph Title Level 4
I. k th V. t b . 4 3.1 Paragraph Title Level 2
Iew b 311P h Title Level 3
CliC e ab In araqraph Tie Leve [t
4 3.2 Ttolo paragrafo livello 2 2.2.1 Paragraph Title Level 3
the Ribbon Bar HEC ey
Conclusions Titolo capitolo 3
Appendix (Not obligatory) 3.1 Paragraph Title Levei 2.
Bibliography 3.1.1 Paragraph Title Level 3
3.1.1.1 Paragraph Title Level 4
Acknowledgments (not obligatory) 3112 Parazraph Title Level 4
3.1.1.3 Paragraph Title Level 4 ...

Page5of26 1186words [[¥ English (United Kingdom)
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STARTING WITH IULM STYLE SHEET
DISPLAYING HEADING STYLES AND PARAGRAPHS
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Documentl mpatibility Mode] - Word

Insert  Design  Layout  References  Mailings  Review  View  Developer

sl q L Find -
z « AaBbC AaBbced AaBb AaBb AaBbCcl 1. AaBb AaBb( AaBbCcl

= Do Bulleted list Figure Ca... Introd/Co... Main Cha... | TNormal | Numbere.. pg P Picture/Fi...

Times New F ~ |13 A A

Cop
Paste . o
 Format Painter I ek

Clipboard [} Font [} Paragraph [ Styles

Styles (Alt~Ctrl+Shift=5)

Preview, manage and customize the
text styles in Word

Use the window to see and edit
formatting details for each style,
nd quickly
your document.

The Style group on the

¥ou can also update s
selected text,

Home tab (right side of

the screen) allows you to

= Document2 [Compatibility Made] - Word x

t t _t . t . Insert  Design  Layout  References  Mailings  Review  View  Developer @ me wha v Signin £ Share
art editing or in - Yo .. i -
S € g or crea g “ TimesNewF-13 | A A Aa- | 4 20 9, asBbC aaBbcad AaBb AaBb AsBbCcl 1. AsBb AaBh( AsBfccr @ R':m
Pﬂffa . I U -asex, ¥ W . A~ By O Bulleted list Figure Ca... Introd/Co... Main Cha.. | TNormal | Numbere.. paragraph.. Pictuf/Fi.. = 5 Select~
styles S o . . e ol catng | o
Styles Tx
Table of contents Default Parforaph Font &
Hyperlink a
Bulleted lis ]
INTRODUCTION/PREMISE 3 BN A
Footer jir)
1 Main Chapter’s Title Level 1 3 Heading 1, Main ChapterSd
1.1 Paragraph Title Level 2 3 Heading 2,paragraph le1 T
1.1. Paragraph Title Level 3 3 Heading 3,paragraph le1 12
1.1.1.1 Paragraph Title Level 4 3 Heading 4 paragraph e\ 12
1.1.1.2 Paragraph Title Level 4 3 TR a
1.1.1.3 Paragraph Title Level 4 3 Humbered L -
Picture/Figure ]
1.2 Paragraph Title Level 2 3 Quote 1
1.2.1 Paragraph Title Level 3 3 Source Figure 1
1.2.1.1 Paragraph Title Level 4 3 Source Table 1
1.2.1.2 Paragraph Title Level 4 Current Document Table )
1.2.1.3 Paragraph Title Level 4 Ctrl+Click to follow link || | Table Caption ]
. . Show Preview
Titolo cap 2 3 Disable Linked Styles
2.1 Paragraph Title Level 2 3 %) A Options..
2.1.1Paragraph Title Level 3 3
2.1.1.1 Paragraph Title Level 4 3
2.1.1.2 Paragraph Title Level 4 3 -
Page50f 26  1186words  English (United Kingdom) [E5] B - 1] + 108%
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DGR st Design  layout  References  Mailings  Review  View

Cut .

S e
Each style has a name, for example: s (TR

Titles introd/conclu/bibliogr/acknow.
Title 1; Main chapter

Title 2; paragraph level 2

Title 3; paragraph level 3

Title 4; paragraph level 4

Thesis body

Caption; Figure Caption

» AaBbC AaBbCd AaBb

Bulleted list  Figure Ca... Introd/Co...

>f contents

>
>
>
>
>
>
>
>

Developer

STYLES CUSTOMIZATION AND APPLICATION

Q Tell mew

+ AaBbC AaBbccd AaBb AaBb AaBbCel 1. AaBb AaBb( AaBbCcL

Bulleted list Figure Ca... Introd/Co.. Main Cha... | TNormal | Numbere... paragraph... Picture

Styles

Use the window to see and edit
formatting details for each style,
create new styles, and quickly
preview styles in your documa

£ share
P Find -

Signin

= to match

Sign in

Figure

D Find ~
AaBb 4aBbCcl 1. AaBb AaBh( AaBbCcl 0 peql
|| 2B Replace
Main Cha.. | TNormal | Numbere.. paragraph.. Picture/Fi | < [y o
Styles nl Editing
Styles
Default Paragraph Font
Hyperlink
Bulleted list
3
1 Footnote Text
Heading 1,Main Chapter
3 Heading 2,paragraph lev
3 Heading 3,paragraph lev
3 Heading 4,paragraph lev
3 Introd/Conclu/Eibliogr
3 Numbered List
3 Quote pic)
3 Source Figure 1
3 Source Table 13
Current Document Table =
Ctrl+Click to follow link | Table Caption 1

Show Preview

3

Disable Linked Styles

% %

Options...

W W Wt
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STYLES CUSTOMIZATION AND APPLICATION
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To modify indents,
paragraph spacing and other
attributes, choose Format

popup menu and click the
name of desired style, use
the pop-up menu to select
the options, then click OK.

+AmBYC aaBbCd AaBh AaBb

Bulleted list Figure Ca.. Introd/Ca., Main Cha..
jang Modify Style ToX
Properties
Name: Heading 1:Main Chapter
Style type: Linked (paragraph and character)
Style based an: 7 Normal v
Style forfollowing paragraph: | T Normal ki

Formatting

Times New Roman v 18 v|B I g| Automatic v

-
4=

Sample Text Sample Text Sample Text Sample Text Sample
Text Sample Text Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Text Sample Text Sample

Text Sample Text Sample Text Sample Text Sample Text

Font: 18 pt, Bold, Kern at 16 pt, Left A
Line spacing: 1,5 lines, Space
After: 24 pt, No widow/orphan control, Keep with next, Don't hyphe;
Tab stops: 0,25 cm, Left, Style: Linked, Automatically update,

el 1

Add tothe Styles gallery [ Automaticall
@ Only in this document O N ents based on this template

Format =

iz - =l x
AaBbCel| 1. £ Sign in Q_Share
TNormal | Num L Find -
‘ Xl 1. AaBb AaBb( AaBbCcl ahn .
es
1al | Nurnbere.. parai Styles - ¥
~
Default Paragraph Font @
Hyperlink a
Bulleted list a3
Caption,Figure Caption 18
Footer Ta
pk:]

Update Heading 1 to Match Selection
Modify...
Select All: (Mo Data)
Remove All: (Mo Data)

(United Kingdom) %
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Heading 1,Main Chapte h‘

Source Figure Ta
Source Table 1a
Table 1a
Table Caption Ia
Show Preview
Disable Linked Styles
M ’5-5'3 ’5} Options..
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HOW TO INSERT OR TO MODIFY INDEX/TABLE OF CONTENTS
THESIS TABLE OF CONTENTS
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Document] [Compatibility Mode] - Word

You can insert an automatic table

of contents according to the s 8 E‘N;;;mf . D [;2; e B D“ 'ﬁ D =T r—
previous procedure (customization °° R e EJ =
- application styles). Perform the
following operations: = ':
1. Place the cursor under bl of aonerte
Index/Table of contents; 6 ; e
Click the References tab \ |
Then on Table of contents i ::"':”:“ '
Choose Insert Table of K ==y b

contents then define desired
format, layers and options.

Custom Table of Contents...

Update Table of Contents ? X

For further details: Updating Table of Contents > In the Table of Contents
group of the References tab click Refresh Table of Contents then
Refresh Page Numbers or Full Table of Contents '

Word is updating the table of contents, Select one

IULM Library / Multimedia Services >
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The analytical index contains
the list of relevant words that
recur in the text, with the
corresponding page number.

This index is very useful in the
context of degree courses in
Interpreting and
communication / Specialised
translation and conference
interpreting

HOW TO INSERT OR TO MODIFY INDEX/TABLE OF CONTENTS
INDEX (EX.: GLOSSARY FOR THE SCIENTIFIC TRANSLATION COURSE)

ANALYTICAL INDEX

ENGLISH ANALYTICAL INDEX

Lemma Pagina
4aCs 17
Abraded culet 51
Abrasion 253
Absorption spectnam -
Allotrope of carbon 60
Alluvial mune 19
Angelina cut 157
Annealug 319
Appraisal 119
Asscher cut 159
Baguette cut 161
Baguillon cut 163
Barocut cut 165
Bearding 54
Bevel ot 167
Bezel facet 81
Big Hole 21
Black dixmond 337
Black wchusions 256
Blemush 258
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HOW TO INSERT OR TO MODIFY INDEX/TABLE OF CONTENTS

ANALYTICAL INDEX
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sert  Design Layout Mailings ~ Review  View  Developer Y m—

in the Index group of the

1 ﬁ‘]lnsertEndnote ‘.-. @‘,,Manage oL — [ Insert Table of Authorities
References tab click Mark e SNetfoorae - 7 sy s | T
Footnote = Show Nates Ciatian = E‘D Bibliography = Caption Eerois-reference

Entry or Mark All for all similar ——_—
entries;

Updare Update Table

Citation

Citations & Bibliography Captions Table of Autharities

Type or edit the customizable
item then enter a secondary or
cross entry according to your

needs;
=

Mark Index Entry e

Subentry: Index

Options

@ ErsrE {"igflex™} | Table of Contents  Table of Figures  Table of Authorities
@® Current page Tint Preview
O Page range Aristotle, 2 A Type: @ Indented Run
» . Calumns: |2 -
Pockmark Asteroid belt. See Jupiter

Fage number format
[ gotd
[ ttalic

Place on the page where you
want to insert the index;

Atmosphere
Earth

[ Right align page numbers

ader: |

Click Insert Index and follow
the guided procedure (next
options)
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HOW TO INSERT OR TO MODIFY INDEX/TABLE OF CONTENTS
ANALYTICAL INDEX
(Second Index)
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fs2 - Word

nnnnnnnn Review  View Developer Q Tell me what vou want to do...

5 Manage Sources

-I-—r EZ7 Insert Table of Authoriti

‘ E3syle ApA - ‘ Update Table Ugfareindex R Update Table
es Citoian - £ Bibliography - c:;;:n [ Cross-reference o
When inserting a second index R s
’

Word replaces the first index with
. Queste e altre tendenze sono il risultato deifigrandi progressi tecnologici
the new one ... U nless the fOl IOWlng fatti in archeologia negli ultimi anni, spiegh il Prof. Gideon Avni, capo
g g . della Divisione Archeologia presso |'Autoritg Israeliana per le Antichita
solution is resorted to : g presso Thut per e A

Select the words and click on R —
References group, Mark entry
tab then on ok. Word adds a
field named XE (If the XE field is
not displayed, click Show/Hide

in the Paragraph group on the
Home tab to activate it)

[EEIGHN  Maiings  Review  View  Developer Q Tell me wh ntto do..

wgn Endnote . r_‘j‘,ManageSourca & D\nserﬂab\ of Figures ¥ D\nsertlnda( ¥ %\nsertTab\eofAuthont\a
Add the parameter “f’ to the XE _ v 2 - =
‘ootnote [gSter APA - Jpdate Tagle Update Index Update Table
. . Insert Insel Mark Mark
field, then choose a unique Nt Chaone EnBbogmpty~  coproRg R by Giaton
[F1 Citations & Bibliography Index Table of Authorities

letter, for ex. “p ” (The second
index will be created on the
basis of letter “p ” ex. { XE “
archaeology ” \f “p”}

Archeologia{-XE"Archeologia™} \

Archasology{ XE:"Archasology"\'e" + [} )
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e HOW TO INSERT OR TO MODIFY INDEX/TABLE OF CONTENTS
ANALYTICAL INDEX (Second Index)

fs2 - Word

Layout  References  Mailings  Review  View  Developer

Cover Page ~ J5] SmartArt i siore W Eﬂﬂ & Hyperlink j [7] Header~ Quick Parts~ [+ MatureLine ~  TT Equation ~
[ Blank Page 1/l Chart J‘:‘ e i AutoText » ymbaol~
- 3 lires Online Shapes 8 Wy Add-ins - Wikipedia  Online Comment =1 A
"= Page Break = Pictures - @ Screenshot- | *P D Video | L Cross-reference [ Page Number~ [E Document Property v
Pages Tables INlustrations Add-ins Media Links Comments Header & Footer Field... ymbols ~

FOrganizer...

Field

Proceed as

Please choose a field Field properties
Click the button below to set ady

Categories: ced field options

follows: Enter > r— =

Quick Parts > Sorgeuton

Hyperlink
I

Field > Index; e

Info

field code; e,

racroButton

. L rMergeField
Click on Fie HEEES
M s ~
ergeSeq =] Preserve formatting during updates

Description:

codes;
Enter the

Field Codes Cancel

~
X

Field

following

Lategories:

parameters: o s =

FileSize ~
Fill-in

INDEX f «p», Solatuion

Hyperlink
i

roperties
ield codes:
INDEX W B~
INDEX [Switches]

IncludePicture

and then on ok [ E=a——.

Info

Keywaords

LastSavedBy

Lirmk

ListMum

MacroButton

MergeField

mMergeRec

MergeSeq ~

[~] Preserve formatting during updates

Description:
Create an index

Hide Codes Sotions... Cancel
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Before creating an Index of figures, it is

essential to add captions to all the

figures and tables that you want
included in your Table of Figures
For more information, see Insert

» Click on the page where you
want to insert the index;

» Inthe Index group of the
References tab click Insert
Table of Figures;.

HOW TO INSERT OR TO MODIFY INDEX/TABLE OF CONTENTS
TABLE OF FIGURES

erences il

1 Add Text - 1 [ Insert Endnote W E [ Insert Table of Authorities
1 Update Table AB) Next Footnate - ERstyle aPA - o . Update Table
Inse Insert - © Mark
Footnote (=l Show Notes Citation + €12 Bibliography - Citation
Content: Footnote Citations & Bibliography Table of Authorities

Table of Figures ? X

Index  Table of Contents | Table of Figures! Table of Autharities

int Preview Web Preview

}igura 1: Text
Figura 2: Text
Figura 3 Text
Figura 4: Text

P i
Figura 1: Text 1|~

Figura 2: Text................. 3

Use hyperlinks instead of page numbers

IULM Library / Multimedia Services



SPECIAL PAGES NUMBERING
JTARTING PAGE NUMBERS FROM THE INTRODUCTION
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Document? [Compatibility Mode] - Word Header & Foo' r To... cal -

References Review  View Q Tell me what you want to do...

[NT nset  Design  Layout Mailings Developer Design

o TimesNewf -[13 - Bhca A (P ©
Copy I aBb AaBb AaBbCcl 1. AaBb AaBb( AaBbCcL
In the Pa ragra h rou Of the . L B I U-aex,x ~ Buletedlist FigulfCa.. Introd/Co.. Main Cha.. | TNormal | Numbere.. paragraph.. Picturesffi |= 1 feptace
&' Format Painter [ select~
Home tab choose ShoW/Hide ( Clipboard “m?u“pwm_ Font . 5] : Styles . Editing
2.1-Paragraph-Tile-Level:2 ... P 3T 1
H 2.1.%Pla.iiagraph-TlgeTL;\'Ei-i‘ 14 - :3 1 Section Break (Next Page)
s aragraj 1tle-Level =+
) tO enable the dISplay Of :.1.12--Paraigr§h-TnleLex-e14 = 31 ( >
2.1.13 Paragraph Title Level 4 -+ 39
. . )
fo rm attl n g m a rkS * ) l-gﬁ’r’:}gjraph-'fé?f;\"élrir ,-: ) 3:
2 g 7 -+ 30
g h-Title Level-4 31
Place with the cursor at the § g
. Titolo-capitolo-3 . 3
end of the page preceding the B o —
3.1.1Paragraph-Title Level-3 = 3
. . 3.1.1.1-Paragraph Title Level 4 -+ 37
2 Title Lev 5
introduction; e 8 :
3.2-Ttolo-paragrafo-ivelio-2 e
3.2.1 Paragraph Title Level 3 =+,
3.2.1.1-Paragraph-Title Level4 -
3.2.1.2 Paragraph Title Level-4 .
321 3Paragraph-Title Level4 -

Conclusi

Dacument! [Compatibility Made] - Word m = Cd

Mallings  Review  View  Davalopar Tall ma what you want t signin 9. sh)

Layout Group
Breaks

Spacing

05 |

Section breaks, then next page

Break (Hext P

aragraph Title Level 4

Appendix ( 3.
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SPECIAL PAGES NUMBERING
STARTING PAGE NUMBERS FROM THE INTRODUCTION
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H - : Document] [Compatibi
I E e T I )
Open the footer by double P (D
clicking on the bottom of the . "
page hosting the introduction. 3
The Design option in Header
and Footer Tools will be ‘
opened ;
Disable Link to Previous

I[ULM Library / Multimedia Services
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10. Click on the 'Page
number' button

11. Then on Format
page numbers;

12. Enter the number

1in Start at and
confirm the
operation by
clicking on OK

SPECIAL PAGES NUMBERING

nnnnn

Bl Topof Page
& Bottom of Page

osition

[f] Current

#8_Format Page Numbers

E;g Remaove Page Numbers

[iq Previous
B Next

r Footer Link to Previous

[

[

t

Different First Page CHeaderfromTop:  125em *

Different Ocd & Even Pages =t Footer from Bottom: 125cm 2| "

Page Mumber Format

Mumber format: | RERERD

|:| Include chapter number

Chapte ith ctyle: |Heading 1
Use se - [hyphen)
Exampl 1-1, 1-A

Page numbering

Ogontinu revious section
(®) Start =

Cancel

I[ULM Library / Multimedia Services
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iulm HOW TO REMOVE NUMBERS FROM BLANK PAGES

Repeat the

procedure, slide 21 e
to 23' by inserting . Page Number Format T X
both a Section ' Number format: |1,2,3, v
- Fonte figura:-da-nowcorfondsre-con lo-stile-della-didarcalia]
break at the end of : T .( [ Include chapter number
. | Chap style: [Heading1 v
the chapter and in L -~ . Um ———
b1 Didaosalintabelat .
the blank page, [ L a ] Examples: 1-1,1-A
: : : ; 1
then proceed as : 5 : : !
. - 1
follows: : e 1
1. Select 4 !
«continue from : 1 Gance
. 1
the previous q !
. 1 1
section» and g 3
confirm the | A S

operation by

CIICkIng on OK Footer -Section 2- Footer -Section 3-

2. Then remove o
the number
from the blank

page
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OTHER USEFUL FUNCTIONS OF WORD
FOOTNOTES
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=] v Nuovo Dacumento di Microsoft Word (2) - Word i3l -

File Home Insert Design Layr.;[ + failings Review  View Developer Q Tell me what you want to do. Signin Q,Sh

% TﬁAddTe}ﬂ' rp! ﬁ‘lnsertEndnote ,_ r‘Manag;eS:tur(s . DInsertTabIeofFlgurs D [ Insert Index +_ (2 Insert Table of Authorities

O Update Table A!:Nu‘t Footnote ~ [g&ty\e: APA o~ Update Table Update Index Update Table
Table of Insert 3 Mark

Contents Footnate =l Show
Table of Contents

Click «References
tab»

Then on Footnotes
and select button
Insert footnote ;
At the bottom of the

I
Notes Citati « EpyBibliography - Captlon Elj Cross-reference Entry Citation
Footnotes ] itations & Bibliography Index Table of Authorities

Footnotefpnd Endnote ? e

Bottom of page b

Ogndnotes: End of document

page indicate the

Footnote layout
Sequence number Columns: m«mtm section layout b
Of the note Format

HNumber format 1,2 3, . b

Custom mark: Symbol...

St

MNumberirog ontinuous b
Apply changes

Apply changes to: | Whole document ~

Insert Cancel Apply
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From Word 2007 and above:

1.

Click on the File Menu
and select

Export or Save As
(Student ID
Number_Name_Surname
);

Click the Options button
and enable Create
Bookmarks

HOW TO CONVERT YOUR THESIS TO PDF

WORD 2007 AND LATER VERSIONS

Fublish what
D D oo e m

word bookmarks
Document properties
==H Document structure tags for accessibility

FPDF options
1150 1s0oos-1 compliant (PDFEAA)
Bitmap text when fonts may not be embedded
[ Encrvpt the document with a password

cancer

LTS ..

—_—
AR T

I[ULM Library / Multimedia Services
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If you don’t have the

PDF option enabled in

Microsoft Word 2007

or later versions:

1. download and
install PDF Creator
from this link:

https://sourceforge
.net/projects/pdfcr
eator/

File/Print

Select PDF Creator
Select High quality.

HOW TO CONVERT YOUR THESIS TO PDF

universita = WORD VERSIONS PREVIOUS TO WORD 2007
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1. Click on File
2. Then on Property
3. Clickon atabinthe

Description
document dialog
box and enter title,
author, subject and
keywords

universita

HOW TO CONVERT YOUR THESIS TO PDF
FINAL PDF METADATA

a sample.pdf - Adobe Acrobat Pro DC

= open... Ctrl+O
f_?: Create »
Sawve As... Shift+Ctri+5 [
Export To
B attach to Email... L
Close Ctri+W
1
I Properties... ST L I
B Print... Ctrl+P
Exit Ctrl -+
Document Properties “

Description | Security | Fonts | Initial View | Custom | Advanced
Descaptoon

e New Software Project

Tite [Softwace Deveicpment

author |

Crested:  2/25/2014 $:53:46 AM
Modfied: 6242014 1230:52 PM
Application: Acrobat POFMaker 11 for Project

......
POF Producer  Acrobat Distiller 11.0 (Windows)
POF Version: 1.7, Adobe Extension Level 3 (Acrobat 9.x)
Location:  C:\Uzers\tucte 000\Documents\
File Size 24236 KB (248,173 Bytes)
PageScze 1100x850m Number of Pages: 12
Tagged POF: No Fast Web View: No
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HOW TO BURN YOUR FINAL PDF TO CD
(WINDOWS 10)
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Insert the blank CD into
the CD player/burner
Insert the flash drive

into the appropriate usb
output
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A burn disc wizard will
appear on the screen;
insert the disc title,
then choose the
option With a CD/DVD
player;

Click Next then wait
while the disc is
prepared for use.

Then wait while the disc

is prepared for use.
Open File Explorer and
drag the pdf you want
to burn;

Click the Manage tab
and then Eject

— | ® With a CD/DVD player |

HOW TO BURN YOUR FINAL PDF TO CD
(WINDOWS 10)

Burn a Disc *

How do you want to use this discC D

|

O Like a USB flash drive on DVD RW Drive (@)
reparing to fermat
Save, edit, and delete files on the disc anytime. The disc will
work on computers running Windows XP or later, (Live File
Systemn)

Disc title: Formatting (702 MB)

Burn files in groups and individual files caggalae edited or
removed after burning. The disc will also on most
computers, (Mastered)

Which one should | choose? |

- u]

Manage

— e Share  View
‘ll’ Cancel [N (> ThisPC > DVDRW Drive () backup v O | Search DVDRW Drive (G) backup

Date modified Type
lcess N
up

Drag files to this folder to add them to the disc.

Drive Tools [ERETELS
OBl comeuter vie Manage
> = eat
- > + Copy to DVD RW Diive () backup
@ Finish burr
Bitlocker | Optimize Cleanup Format|  AutoPlay .
¥ » This| Format Search This PC
Format the selected disk %
uick access . xio Burn Disc Vi
OneDrive
- Local Disk (C:)
3 Thi: S R
L= 14.8 GB free of 79.3 GB
Network INTO (D:
e
24 ree of 69.4 GB
G backup
i f 702 MB

Ii

'
3
/
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OTHER USEFUL FUNCTIONS OF WORD

universita
iulm

» How to combine and merge multiple files into one (thesis
chapters);

» How to insert and fix images in Word
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Create a new blank
document and then
configure the page
layout settings (based on
the Style Sheet) for the
documents that are
going to be merged.
Click on the drop-down
to the right of the
button 'Object' then on
‘Text from file '

Select the files you want
to merge and combine
to one by holding the _
CTRL _ (Windows_ ) or _
CMD_ (Mac) key then
Insert

e @ Design Hirans : ] o ) T e e T
Z =

OTHER USEFUL FUNCTIONS OF WORD
OW TO COMBINE AND MERGE MULTIPLE FILES (THESIS CHAPTERS) INTO ONE

Documen it1 - Word

ou want to do.. Sign in
B ! %) I SmartArt il store W E‘ﬂ 2, Hyperlink +j [ Header~ [E Quick Parts~ [# Signature Line T Equation ~
Iy 1/l Chart il |> Bookmark [] Footer~ 4 WordArt - [F3 Date & Tingg Raigbol -
Table  Pictures Online STEM & My Add-ins + Wikipedia  Online Comment Text
o Pictures - BMgeenshot~ Y Video | [ Cross-reference [# Page Number= | - © DropCap- [ LghfEet
Tables lllustrations Add-ins Media Links. Commen ts Header & Footer TegfS Object... Symbols ~

Insert Text from File

Insert the text from afile int your
publication.

If you have a text box selected, the
text is added to the selected text
box; otherwise, a new ted boxis
created.

[ Questo PC
[ Desktop 5 Chapter 1
] Documenti F| Chapter 2
3 Download 5| Chapter 3
&= Immagini
B Musica
B Video
= biblio$ (\srv-fs
= biblio$ (srv-fsz

= FS (\Client) (F)
= lbrahima.Mbeng

= DS (WClient) (U,

< >

Range:

File name: [ ~| [m1werd Documents
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OTHER USEFUL FUNCTIONS OF WORD

laner;'\egERT/FIX IMAGES (WORD 2007 AND LATER VERSIONS)

i I
Nuovo Dacumento di Microsoft Word (2) - Word

.. Info
The anchor function in Word
Nuovo Documento di Microsoft Word (2)

a”OWS you to f|X the exaCt en \\xdm-fs.iulm.local » profiless » FolderRedirection » lbrahima.Mbengue = Desktop
images in the stylesheet, so that 2
they remain in place even in 0

Total Editing Time 0 Minutes

Protect Document Properties ~
Control what types of changes people can make to this document. e 0 bytes

f 1 Share s Inspect Document Title pdd a tile
Ca Se O C h a n ge I n yO U r \a Before publishing this file, be awars that it contains: 1S f‘dd atag
o Checkfor | Comments Add comments

" Searching for issues

d OC u m e nt- - Related Dates

Last Modified
'_hl Manage Document Created Today, 11:34
Q| Check in, check out, and recover unsaved changes. (e et
Manage ™
- Today, 16:16 (autosavi

)
Today, 14:21 (autosave) Related People
Today, 13:44 (autosave) Author
€)
€)

1. Display the File tab of the
ribbon and then click B Tody 217t

Today, 11:57 (autosav

Ibrahima.Mbengue

Add an auther
Last Modified By Not saved yet

Options

Click Display at the left side
of the dialog box, Select the
Object Anchors check box
and press OK (on Mac:
Preferences /Display/Object el
Anchors o

Related Documents
| e
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3. Clicking twice on the image
Word displays Format Picture
dialog box to change the
image layout (Top right
position)

Choose Size and Position
option_in the style sheet to
enable Fixed position on
page with several options
(moving the image in front of
text and behind text, or
flowing text around

the image with a square
wrap, tight wrap or top and
bottom wrap)

OTHER USEFUL FUNCTIONS OF WORD
HSERT/FIX IMAGES (WORD 2007 AND LATER VERSIONS)

Document1 [Compatibility Mode] - Word
View  Dewalnnn-

Brig s Pictures

’ @) | #(|Height 7,62cm
(D Contrast~ 9] Reset Picture

L

rouf

Shadow Selectior Crop S width: -

& Recolor - By : 4 Pane. “ARotate~ G Wikie) 1348 cm
Adjust Shadow Effects Border Arrange

El—

Lt {;gﬂl—ie\ghb 762cm

rour
Crop =7 Width: 1348cm
otate ~

ghtness~ [Z Compress Pictures D o
ntrast~  “L Reset Picture oo o

Shadow Picture
color~ Effects ~

Adjust Shadow Effects Size

Ft More Layout Options...
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